Quick Guide to Implementing SAPUI5 Design Rapid-deployment Solution
Icons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>!</td>
<td>Caution</td>
</tr>
<tr>
<td></td>
<td>Example</td>
</tr>
<tr>
<td></td>
<td>Note</td>
</tr>
<tr>
<td></td>
<td>Recommendation</td>
</tr>
<tr>
<td></td>
<td>Syntax</td>
</tr>
</tbody>
</table>

Typographic Conventions

<table>
<thead>
<tr>
<th>Type Style</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Example text</em></td>
<td>Words or characters that appear on the screen. These include field names, screen titles, pushbuttons as well as menu names, paths and options.</td>
</tr>
<tr>
<td></td>
<td>Cross-references to other documentation.</td>
</tr>
<tr>
<td><strong>Example text</strong></td>
<td>Emphasized words or phrases in body text, titles of graphics and tables.</td>
</tr>
<tr>
<td><code>EXAMPLE TEXT</code></td>
<td>Names of elements in the system. These include report names, program names, transaction codes, table names, and individual key words of a programming language, when surrounded by body text, for example, SELECT and INCLUDE.</td>
</tr>
<tr>
<td><em>Example text</em></td>
<td>Screen output. This includes file and directory names and their paths, messages, source code, names of variables and parameters as well as names of installation, upgrade and database tools.</td>
</tr>
<tr>
<td><code>EXAMPLE TEXT</code></td>
<td>Keys on the keyboard, for example, function keys (such as F2) or the ENTER key.</td>
</tr>
<tr>
<td><em>Example text</em></td>
<td>Exact user entry. These are words or characters that you enter in the system exactly as they appear in the documentation.</td>
</tr>
<tr>
<td><code>&lt;Example text&gt;</code></td>
<td>Variable user entry. Pointed brackets indicate that you replace these words and characters with appropriate entries.</td>
</tr>
</tbody>
</table>
# Contents

1 Purpose ................................................................................................................. 5
2 Solution Overview .................................................................................................... 6
3 System Setup & Preparation ....................................................................................... 8
   3.1 Release and Support Package Level ...................................................................... 8
3.2 Required Product Versions and Software Components .......................................... 9
   3.2.1 System Landscape .......................................................................................... 10
3.3 Integrated Development Environment Installation ................................................... 12
   3.3.1 Eclipse IDE for Java EE Developers ............................................................... 12
   3.3.2 SAPUI5 Plugin for Eclipse Studio ................................................................... 12
   3.3.3 Apache TomCat Server .................................................................................. 13
3.4 SAPUI5 Integration Installation .............................................................................. 14
   3.4.1 Plugin for Team Provider ............................................................................... 14
   3.4.2 SAPUI5 Add-On for SAP NetWeaver .............................................................. 14
3.5 Frontend Components Installation ......................................................................... 14
   3.5.1 SAP NetWeaver Business Client .................................................................... 14
   3.5.2 Portal ............................................................................................................. 15
3.6 SAP Notes and Messages ...................................................................................... 15
3.7 Specific Activities .................................................................................................. 16
   3.7.1 Download and Import Example SAPUI5 Files .................................................. 16
4 Evaluate Business Content/Processes ....................................................................... 19
   4.1 Review of Business Processes ............................................................................ 19
   4.2 User Maintenance and Settings .......................................................................... 19
   4.2.1 Assigning a Role to a User ............................................................................ 19
4.3 Creation and Change of Queries in Personal Object Worklists (POWLs) .............. 21
   4.3.1 Create Query ................................................................................................. 21
   4.3.2 Change Query ............................................................................................... 22
4.4 Errors with SAP NetWeaver Business Client (SAP NWBC) .................................. 23
   4.4.1 Queries Show No Data/No Columns ............................................................... 23
   4.4.2 Printing Functionality ..................................................................................... 23
5 Security Aspects ....................................................................................................... 24
   5.1 General Security Guidelines ............................................................................... 24
   5.2 User Administration and Authentication ............................................................. 24
       5.2.1 Creation of Administration User ................................................................. 24
       5.2.2 Creation of Development User ................................................................... 24
       5.2.3 Creation of Business User ......................................................................... 25
5.3 Roles Management ................................................................................................. 25
Quick Guide to Implementing the SAPUI5 Design Rapid-deployment Solution V1.731

1 Purpose

This quick guide provides step by step information you need to implement the complete SAPUI5 Design rapid-deployment solution.

Before proceeding with this document you must have completed the following activities:

- Defined the scope relevant for your project
- Finalized technical prerequisites
- Staffed and made available the required resources

This document does not provide a general overview and explanation of SAP Best Practices. For more information about the Best Practices concepts, see the related documentation on [http://service.sap.com/bestpractices](http://service.sap.com/bestpractices) and follow the links to the Learning Center.

This document is intended for the following project roles, which already have a sound knowledge of SAP Best Practices:

- System administrators and basis consultants
  - System set up and preparation including troubleshooting
- Activation/implementation consultants (basis or application consultants)
  - Activation/implementation of business content and processes
- Business consultants
  - Evaluate business content/processes including troubleshooting
  - FAQ and further information for extended usage of the package

💡 This document is not primarily intended for user experience (UX) designers and developers. Some information may be helpful to you, for example, [Download and Import SAPUI5 Files](http://service.sap.com/bestpractices). You will find information more relevant to the design and development process in the respective configuration guides.
2 Solution Overview

SAPUI5 Design rapid-deployment solution V1.731

- Is based on SAP NetWeaver 7.31
- Provides guidance for applying the SAPUI5 toolkit to design and develop user interfaces according to SAP Fiori design principles.
- Provides an accelerated deployment of the required configuration settings.
- Provides additional reference examples for enabling implementation of other SAPUI5 user interfaces using NetWeaver Business Client.

This solution provides guidance on best practices for designing and developing user experiences using the principles and guidelines for SAP Fiori. These user interfaces are created using the SAP UI Development Toolkit for HTML5 (referred to as SAPUI5). The primary focus of this solution is to provide documentation on design and development principles for SAP Fiori. In addition to this, the solution provides enablement for other SAPUI5 topics, covering some of the technical aspects which are the foundations for the methodology used in SAP Fiori.

- SAP Fiori Design Principles
  This covers the design principles and user interface components that are used in SAP Fiori. This is intended for designing and developing a user interface using the SAPUI5 toolkit according to the SAP Fiori concept. This is relevant for:
  - designers working on user interface design according to SAP Fiori;
  - developers working on user interface development according to SAP Fiori.

SAP Fiori is a concept that provides a simple, intuitive user experience across diverse business transactions. The consistent and responsive design allows users to seamlessly experience the user interfaces across interaction channels – desktop, tablet and mobile – as they accomplish their tasks quickly and easily.

💡 SAP has delivered SAP Fiori user interfaces for many of the most frequently used business transactions. However this solution enables you to apply the same approach and concepts to your own processes to achieve a similar user experience with the same business benefits that include:
  - Increased employee productivity and satisfaction
  - Reduced work completion time
  - Increased adoption of business processes.

- SAP UI Development Toolkit for HTML5
  This is provided for reference and covers some examples of the technology that is included in the SAPUI5 toolkit. This is relevant for
  - developers working on user interface development with the SAPUI5 toolkit;
  - developers working on the connection of data from the back-end system to the user interface;
  - system administrators or consultants working on the system landscape to support the SAPUI5 toolkit.

The primary configuration guides delivered with this solution are focused on designing and creating user experiences (sometimes referred to as apps) based on SAPUI5 and SAP Fiori design principles. Additional configuration guides, which are independent of the above primary focus, have been provided for reference in regards to more general SAPUI5 configuration.
• SAP Fiori
  This topic includes three configuration guides for the solution:
  o SAP Fiori Design (building block U55)
  o SAP Fiori User Interface (building block U56)
  o SAP Fiori Checklist (building block U58)
  Building block U55 is a pre-requisite for building blocks U56 and/or U58. The building blocks U56 and U58 can be installed independently of each other.

• SAP UI Development Toolkit for HTML5.
  This topic includes four configuration guides for the solution:
  o SAPUI5 General Configuration (building block U50)
  o SAPUI5 Configuration for Sales and Distribution (building block U51)
  o SAPUI5 Configuration for Project Services (building block U52)
  o Theme Designer for SAP Fiori (building block MF4)
  Building block U50 is a pre-requisite for building blocks U51 and/or U52. The building blocks U51 and U52 can be installed independently of each other.
  Building block U50 is also a pre-requisite for building block U56, in that it explains the SAPUI5 fundamentals that are used for the SAP Fiori user interface that is included in building block U56.
  Building Block MF4 is independent of all other building blocks and provides documentation on using the theme designer for SAP Fiori.
3  System Setup & Preparation

Prior to installing and activating an SAP Best Practices package (SAP BP package), the target SAP Application Server (AS) must be installed together with the Support Package Stack (SPS) specified in the section Required Product Versions and Software Components. Additionally, the SAP Notes named in the SAP Notes and Messages section in this guide must be implemented.

3.1 Release and Support Package Level

The deliverables of SAP Best Practices packages were developed and tested in a system landscape with specific release and support package (SPS) level. If the SPS level in your system is different, there may be errors during the activation. You may be able to perform the activation activities manually using the configuration guides, but errors may still occur.

⚠️ Make sure that your system meets the minimum SPS level requirements. In case your system has an exceptional SPS level compared to the SAP Best Practices requirements, only limited support can be provided.

If you need a higher SPS level in your system, for example, because of additional functionality, first import and activate the SAP Best Practices package on the SPS levels as mentioned below, then update your system to the target SPS level.

The support package levels relevant for the solution package are listed together with the required components in the Required Product Versions and Software Components section.

Receiving the Software at the Correct SP Level

For delivery of the software, an installation number and a corresponding license agreement are required. An S-USER is required to order software in the Software Catalog or download from the SAP Software Download Center (SWDC) on SAP Service Marketplace (SMP). You can only order unrestricted SAP software. Contact the SAP contract department to ask for a physical shipment or create a customer message on component XX-SER-GEN-CONTR.

For downloading SPSs, use the Maintenance Optimizer in your SAP Solution Manager system. You can also select relevant SPSs manually one-by-one via the SWDC on SAP Service Marketplace:


⚠️ Only the current Service Release (SR) is delivered to SAP customers/partners via the SWDC on SMP and standard delivery (for example, the Software Catalogue). If you encounter the situation that the required SPS for correct SAP BP packages activation is based on a SPS level lower than the current Service Release, the request for the necessary SPS is handled by a customer message. For details, see SAP Note 925690 Standard Ordering Procedures for SAP Software.
### 3.2 Required Product Versions and Software Components

The table lists all software required to implement and run the solution:

<table>
<thead>
<tr>
<th>Product</th>
<th>Product Version</th>
<th>Component</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Eclipse IDE for Java EE Developers</td>
<td>Juno</td>
<td>-</td>
<td>Integrated Development Environment for SAPUI5</td>
</tr>
<tr>
<td>SAPUI5 Tools ECLIPSE PLUGIN</td>
<td>SAPUI5 Tools ECLIPSE PLUGIN 100 SP06</td>
<td>SAPUI5 DevToolkit: Plugins</td>
<td>Software Component Version: SAPUI5 TOOLS IDE PLUGIN 1.00 Also available as part of UI add-on for SAP NetWeaver</td>
</tr>
<tr>
<td>SAP NetWeaver</td>
<td>SAP enhancement package 1 for SAP NetWeaver 7.3 SP08</td>
<td>Application Server ABAP</td>
<td>Software Component Versions: SAP_ABA 7.31 SAP_BASIS 7.31</td>
</tr>
<tr>
<td>SAP enhancement package for SAP ERP</td>
<td>SAP enhancement package 6 for SAP ERP 6.0 SP08</td>
<td>Central Applications</td>
<td>Software Component Version: SAP_APPL 6.06</td>
</tr>
<tr>
<td>UI add-on for SAP NetWeaver</td>
<td>UI add-on 1.0 for SAP enhancement package 3 for SAP NetWeaver 7.0 SP06</td>
<td>Integration Services: All SAPUI5 DevToolkit: All SAPUI5 DevToolkit: Plugins Frontend</td>
<td>Software Component Versions: SAP UI ADD-ON INFRA V1.0 SAP UI2 SERVICES V1.0 SAPUI5 CLIENT RT AS ABAP 1.00 SAP IW BEP 200 SAP UI2 FOUNDATION V1.0 SAP UI2 IMPL. FOR NW 7.00 V1.0 SAP UI2 IMPL. FOR NW 7.01 V1.0 SAP UI2 IMPL. FOR NW 7.02 V1.0 SAP UI2 IMPL. FOR NW 7.31 V1.0 SAPUI5 TEAM PROV AS ABAP 1.00 SAPUI5 TEAM PROV IDE 1.00 SAPUI5 TOOLS IDE PLUGIN 1.00 NWBC NW BUSINESS CLIENT 4.0</td>
</tr>
<tr>
<td>SAP NetWeaver</td>
<td>SAP NetWeaver</td>
<td>Gateway Server Core</td>
<td>Software Component</td>
</tr>
</tbody>
</table>

© SAP AG
Gateway   | Gateway 2.0 SP07   | NW 703/31 Gateway BEP | Versions: 
GW_CORE 200 
SAP IW FND 250 
SAP IW BEP 200 

Apache TomCat Server | TomCat 7 | - | Recommended for testing in IDE

The optional software is required for back-end data connection, for example for implementing the example user interfaces in:

- **SAP Fiori User Interface** (building block U56): *for the optional example user interface with*
- **SAPUI5 Configuration for Sales and Distribution** (building block U51)
- **SAPUI5 Configuration for Project Services** (building block U52)

You can design and develop SAPUI5 user interfaces with binding only to dummy data, in which case these software products are not required.

For testing purposes of SAPUI5 application projects in the integrated development environment, SAP recommends the use of the Apache TomCat server.

Usually, required software components and SPS levels are downloaded using the Maintenance Optimizer in SAP Solution Manager. Alternatively, you can download the software manually from the SAP Software Download Center (SWDC) on SAP Service Marketplace:

- For installing software, go to [http://service.sap.com/swdc](http://service.sap.com/swdc) → *Installations and Upgrades* → *Browse our Download Catalog*
- For support packages, go to [http://service.sap.com/swdc](http://service.sap.com/swdc) → *Support Packages and Patches* → *Browse our Download Catalog*

For detailed information on SPS definition for the SRs of SAP ERP, see SAP Note 774615 *Support Package levels of ERP/ECC installations/upgrades.*

### 3.2.1 System Landscape

#### 3.2.1.1 Integrated Development Environment

The integrated development environment (IDE) is centered on the Eclipse environment which is installed locally for each developer. Additionally, a dedicated SAPUI5 plugin must be installed in the Eclipse environment. This includes tools specific for the SAPUI5 toolkit and integrates them into the Eclipse environment.

During the development process, the recommended testing environment is the Apache TomCat server. The TomCat server is downloaded and then installed in the Eclipse integrated development environment.

The elements of the IDE are illustrated in *SAP Fiori Integrated Development Environment.*
3.2.1.2 Integration with Back-End Data

The SAPUI5 Fiori designed application is developed in the Eclipse IDE. Once the development of the user interface has been completed, the user interface is deployed to the SAP NetWeaver Gateway server system. The data binding for the user interface must be connected to back-end data from the application system. After it has been successfully deployed, the user interface can be executed by the business user via a number of different methods, for example:

- directly calling the URL for the user interface from a role;
- from a launch page;
- SAP NetWeaver Business Client;
- a portal.

SAP NetWeaver Gateway is required in order for the user interface to access the data in the back-end. The SAP NetWeaver Gateway server can either be local, i.e. in the same system as the application, or remote, i.e. in a separate system which communicates with the application system via Remote Function Call.

An illustration of the system landscape for design time and run time is provided in SAPUI5 System Landscape.
SAPUI5 System Landscape

3.3 Integrated Development Environment Installation

3.3.1 Eclipse IDE for Java EE Developers
You require the *Eclipse IDE for Java EE Developers* as the development environment for the SAPUI5 user interface. This is available at [http://www.eclipse.org/downloads/moreinfo/jee.php](http://www.eclipse.org/downloads/moreinfo/jee.php).

💡 The Eclipse environment must be installed locally for each developer working on developing SAPUI5 user interfaces.

3.3.2 SAPUI5 Plugin for Eclipse Studio
In order to work with SAPUI5 tools in the Eclipse environment you must download ABAP development tools for the use in the Eclipse environment. This is available on the SAP Software Download Center (SWDC) on SAP Service Marketplace. Go to [http://service.sap.com/swdc](http://service.sap.com/swdc), and then choose Search for Software Downloads. Conduct a search with the following entries:

<table>
<thead>
<tr>
<th>Search Term</th>
<th>SAP ABAP IN ECLIPSE 2.0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search Method</td>
<td>Exact Term</td>
</tr>
<tr>
<td>Search Area</td>
<td>Support Packages and Patches in Maintenance</td>
</tr>
<tr>
<td>Search Objects</td>
<td>☑ Software Component Versions</td>
</tr>
</tbody>
</table>
Choose *Search*. On the *SAP Software Download Center* screen, select *SAP ABAP IN ECLIPSE 2.0*. In the dialog box for *SAP ABAP IN ECLIPSE 2.0 (SUPPORT PACKAGES AND PATCHES)* choose # OS independent.

Add the listed file to your download basket.

This has to be installed locally for each developer working on developing SAPUI5 user interfaces in the Eclipse environment.

This plugin is also available as part of UI add-on 1.0 for SAP enhancement package 3 for SAP NetWeaver 7.0 in the component SAPUI5 Dev Toolkit: Plugins.

For additional information on downloading and installing SAPUI5 tools, you can refer to the following note:

<table>
<thead>
<tr>
<th>SAP Note #</th>
<th>Description</th>
<th>Component</th>
<th>Area</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>1747308</td>
<td>Installation Guide UI development toolkit for HTML5 (SAPUI5)</td>
<td>CA-UI5</td>
<td>Recommendations/additional info</td>
<td>Download and installation instructions</td>
</tr>
</tbody>
</table>

Several documents containing guides for installation of SAPUI5 tools and add-ons for the Eclipse environment are attached to this note.

For details on applying the plugin to your Eclipse environment, refer to chapter *Installing SAPUI5 Tools* of the *UI development toolkit for HTML5 Installation Guide* that is attached to the note.

Keep the SAPUI5 Plugin for Eclipse Studio up to-date. You can check the version of the SAPUI5 Plugin in the Eclipse Studio itself by choosing *Help ➔ About Eclipse (SAPUI5)*. In the dialog box *About Eclipse (SAPUI5)* choose one of the tiles showing SAPUI5. The version of the plugin is displayed in the dialog box *About Eclipse (SAPUI5) Features*.

### 3.3.3 Apache TomCat Server

The recommended test environment for SAP Fiori projects within the IDE is Apache TomCat Server.

The Apache TomCat server can be downloaded from [http://tomcat.apache.org/download-70.cgi](http://tomcat.apache.org/download-70.cgi).

For further details on downloading the server and integrating it to the Eclipse environment refer to section *Set up Tomcat to test SAPUI5 applications* in the *Developer Guide for User Interface Add-On*.

For information on testing with the server refer to the section *Test in SAPUI5 Application Preview* in the *Developer Guide for User Interface Add-On*.

This has to be installed locally for each developer working on developing SAPUI5 user interfaces in the Eclipse environment.

For information on enabling backend access for local testing, refer to the SAP UI5 toolkit documentation *Enabling Backend Access for local testing*. 
3.4 SAPUI5 Integration Installation

3.4.1 Plugin for Team Provider

In order to share SAPUI5 applications that you develop in the Eclipse environment with the SAP system, you require the Team Provider Plugin in the Eclipse environment.

This has to be installed locally for each developer who is deploying SAPUI5 user interfaces from the Eclipse environment to the SAP backend system.

For information on downloading and installing the plugin, you can refer to the following note:

<table>
<thead>
<tr>
<th>SAP Note #</th>
<th>Description</th>
<th>Component</th>
<th>Area</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>1747308</td>
<td>Installation Guide UI development toolkit for HTML5 (SAPUI5)</td>
<td>CA-UI5</td>
<td>Recommendations/additional info</td>
<td>Download and installation instructions</td>
</tr>
</tbody>
</table>

An installation guide for installation for UI development toolkit for HTML5 is attached to this note. In particular refer to the section Installing SAPUI5 Tools.

3.4.2 SAPUI5 Add-On for SAP NetWeaver

To download the SAP UI Add-On for SAP NetWeaver, go to the SAP Software Download Center (SWDC) on SAP Service Marketplace:

http://service.sap.com/swdc, then choose SAP Software Download Center → Installations and Upgrades → Browse Our Download Catalog → SAP NetWeaver and complementary products → UI ADD-ON FOR SAP NETWEAVER → UI ADD-ON 1.0 FOR NW 7.03 → Installation

Add all the listed files to your download basket.

To download the appropriate Support Package for SAP UI Add-On for SAP NetWeaver, go to the SAP Software Download Center (SWDC) on SAP Service Marketplace:

http://service.sap.com/swdc, then choose SAP Software Download Center → Support Packages and Patches → Browse Our Download Catalog → SAP NetWeaver and complementary products → UI ADD-ON FOR SAP NETWEAVER → UI ADD-ON 1.0 FOR NW 7.03 → Support Package Stack Download

Follow the instructions to add the required SP stack to your download basket.

This includes the file SAPUI5 TOOLS IDE PLUGIN 1.0 for the SAPUI5 plugin for Eclipse studio. You can download it here if you have not already downloaded in the steps described in chapter SAPUI5 Plugin for Eclipse Studio. In either case, the files have to be installed locally for each developer working on developing SAPUI5 user interfaces in the Eclipse environment.

3.5 Frontend Components Installation

3.5.1 SAP NetWeaver Business Client

In order to run the example user interfaces in the SAP NetWeaver Business Client, the following SAP frontend component must be installed:

- SAP NetWeaver Business Client 4.0.
Ensure that you have installed the latest and appropriate SAP frontend components.
UI add-on for SAP NetWeaver includes SAP NetWeaver Business Client 4.0 as a component. However, you can also download the SAP frontend component separately. To do this, go to the SAP Software Download Center (SWDC) on SAP Service Marketplace: http://service.sap.com/swdc, then choose SAP Software Download Center → Support Packages and Patches → Browse Our Download Catalog → SAP Frontend Components → NETWEAVER BUSINESS CLIENT → NWBC NW BUSINESS CLIENT 4.0 → Win 32
Add the file titled NWBC400 to your download basket.

For further information on working with the SAP NetWeaver Business Client, refer to SAP NetWeaver Business Client.

A SAPUI5 user interface will not run in SAP NetWeaver Business Client for HTML. In order to run the user interface you must install and run SAP NetWeaver Business Client for Desktop.

### 3.5.2 Portal

SAPUI5 user interfaces, including Fiori designed applications, can be run on desktop PCs, tablets and smart phones using a portal.

### 3.6 SAP Notes and Messages

If issues become apparent after shipment of this SAP Best Practices package (and hence of this document), an SAP Note exists to document how to solve the issues.

Before you start the activation of the related SAP Best Practices scope, check the latest version of the SAP Note for the solution package to obtain updates and corrections for problems that have not become apparent until after shipment.

<table>
<thead>
<tr>
<th>SAP Note #</th>
<th>Description</th>
<th>Component</th>
<th>Area</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>1844984</td>
<td>UI2_FND (SP03): Selection criteria for POWL-OData service</td>
<td>CA-U12-INT-BE</td>
<td>Program error</td>
<td>Required for OData service for POWL applications</td>
</tr>
<tr>
<td>1847849</td>
<td>UI2_FND (SP03): Enable cache for OData services</td>
<td>CA-U12-INT-BE</td>
<td>Program error</td>
<td>Recommended for performance of POWL applications, particularly for large data sets.</td>
</tr>
</tbody>
</table>

Apply all SAP Notes to the system via the SAP Note Assistant (transaction SNOTE). All SAP Notes mentioned below must have the implementation status Completely implemented. Some SAP Notes require manual action before you set the status to Completely implemented.

To avoid activation errors as a result of generating loads, perform a mass generation using transaction SGEN as described in SAP Note 481548.

The following SAP Note can be implemented for SAP Best Practices, for instance for the SAP Best Practices roles:

<table>
<thead>
<tr>
<th>SAP Note #</th>
<th>Description</th>
<th>Component</th>
<th>Area</th>
<th>Remark</th>
</tr>
</thead>
</table>
SAP Best Practices
Quick Guide to Implementing SAPUI5 Design rapid-deployment solution

<table>
<thead>
<tr>
<th>SAP Note #</th>
<th>Description</th>
<th>Component</th>
<th>Area</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>1301301</td>
<td>Release Strategy for SAP Best Practices Package ABAP Add-ons</td>
<td>BC-UPG-ADDON</td>
<td>Activation</td>
<td>SAP Note 1301301 refers to other notes. Always check the referenced notes and follow the instructions. Attached to this add-on specific note you can find the corrections for the add-on. Always apply the correction transport for the corresponding add-on.</td>
</tr>
</tbody>
</table>

SAP Fiori user interfaces are role-based, so that the business user can access those apps that are relevant to their work and the activities they need to complete. The configuration guides included in this solution provide further details on including the SAP Fiori apps in example roles. As these are very much example roles, these roles are not included in the SAP Best Practices add-on. Furthermore these example roles are also not integrated with the roles included in the SAP Best Practices add-on. Implementation of the SAP Best Practices add-on is not a pre-requisite for this solution.

3.7 Specific Activities

3.7.1 Download and Import Example SAPUI5 Files

Use
The purpose of this activity is to download the example SAPUI5 files that contain the definitions of the reference SAPUI5 user interfaces and import them to your Eclipse environment. The files are available for download in the SAP Download Center.

The files provided are examples of the SAPUI5 user interfaces for the configuration guides
- SAP Fiori User Interface (building block U56);
- SAPUI5 Configuration for Sales and Distribution (building block U51);
- SAPUI5 Configuration for Project Services (building block U52).

They can be deployed without further modifications to your SAP NetWeaver Gateway system.

The following table provides an overview of the example files, and for which building block they are relevant:

<table>
<thead>
<tr>
<th>File Name</th>
<th>Building Block</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>BP_SAPUI5_SD.zip</td>
<td>U51</td>
<td>Sales Order</td>
</tr>
<tr>
<td>BP_SAPUI5_PS.zip</td>
<td>U52</td>
<td>Project Services</td>
</tr>
</tbody>
</table>
BP_SAPUI5_CC.zip | U52 | Library for custom control in Project Services user interface
BP_SAPUI5_FIORI_EXAMPLE.zip | U56 | Example SAP Fiori application project with launch page and four app types
Data binding to dummy data within application project
BP_SAPUI5_FIORI_EXAMPLE_WITH_BACK_END.zip | U56 | Example SAP Fiori application project with launch page and two app types
Data binding to back-end data

The procedure to deploy SAPUI5 content to an SAP ERP system is described in the configuration guide SAPUI5 General Configuration (U50).

3.7.1.1 Download Example SAPUI5 Files

Use
A SAPUI5 user interface is a collection of files of various functions such as
- Web Services
- Java Resources (source code and libraries)
- JavaScript Resources (source code and libraries)
- Web Content

For one user interface these are collected within a zip format file. This file is downloaded to your network.

One zip format file can contain folders for two or more user interfaces.

Procedure
To download the example SAPUI5 files, go to the SAP Software Download Center (SWDC) on SAP Service Marketplace:
http://service.sap.com/swdc, then choose SAP Software Download Center → Installations and Upgrades → Browse our Download Catalog → SAP Rapid Deployment solutions → SAPUI5 Design rapid-deployment solution → SAP RDS SAP UI5 → SAP RDS UI5V2.100 → # OS independent
Add the download object with the title SP00 for SAP RDS UI5 V2.100 to your download basket.

Results
You have downloaded the files that contain the SAPUI5 interface. You will need to import these files into the Eclipse environment for further processing before deploying them to your SAP system.

3.7.1.2 Import Example SAPUI5 Files to Eclipse Environment

Use
In this step you import the files for the user interface, creating a new project. The files are imported into the Eclipse environment as a project containing all the files required for the definition of a SAPUI5 user interface.
Once files have been imported into a project in the Eclipse environment further modifications can be made to the JavaScript coding.

For the files imported in the steps below, you do not need to make further modifications in the Eclipse environment to the example user interfaces. You can deploy the user interfaces to an SAP system as they are.

**Procedure**

1. Open the Eclipse tool.
2. Choose menu *File → Import…*
3. In the dialog box *Import: Select, select Existing Projects into Workspace in the folder General.*
4. Choose *Next.*
5. In the dialog box *Import: Import Projects, choose Select archive file:*
6. Choose *Browse* to select the file from your network.
7. Choose *Open.*
8. Select the projects you wish to import.
9. Choose *Finish.*

**Result**

The definition for the SAPUI5 user interface has been imported to a new project in the Eclipse environment. The project and all files belonging to it are available in the Workspace *Project Explorer.*

💡

A description of the process to deploy the SAPUI5 files to an SAP system from the Eclipse environment is included in the section *Configure in SAP System* in the configuration guides

- *SAP Fiori User Interface* (building block U56);
- *SAPUI5 Configuration for Sales and Distribution* (building block U51);
- *SAPUI5 Configuration for Project Services* (building block U52).
4 Evaluate Business Content/Processes

The following sections describe the activities that have to be done by the business consultant who is taking care that the business processes work as desired.

- The section Review of Business Processes provides an overview where the business consultant can get information on the SAP Best Practices scenarios activated in the system.
- The section User Maintenance and Settings outlines the activities that the business consultant has to perform to enable system users to exploit the business process documentation. It describes the required user settings.
- The section Creation of Queries in Personal Object Worklists (POWLs) refers to information that is needed when you work with SAP NetWeaver Business Client (NWBC). In several business process documents, it is required that you create queries. In such cases, refer to the description as outlined below.
- The section Errors during Usage of Activated Package lists errors that users might face in the system when applying the business process documentation. The information provided helps to solve such errors.
- The section Errors with SAP NetWeaver Business Client (SAP NWBC) describes possible errors that only occur when using SAP NWBC.

4.1 Review of Business Processes


On the Business Process Documentation page, you can access the individual business process descriptions containing the following links:

- The business process documentation (BPD) provides a detailed process step description of the business scenario.
- The configuration guide describes crucial parts of the system configuration of the respective process. Together with the configuration guides of the underlying building blocks, you can track which system settings have been configured. Due to the technical concept, not all scenarios have configuration applied on a top level. For such scenarios, the necessary configuration is described in the configuration guides of the underlying building blocks. For more information on the building block concept, see the Step-by-Step Guide, Deploy: Train Key Users, accelerator Content Library.

You can use the documents as described above to review the business processes you are interested in. Use the business process documentation (BPD) to evaluate the process in the system.

4.2 User Maintenance and Settings

4.2.1 Assigning a Role to a User

If you plan to use the SAP NetWeaver Business Client (NWBC) interface, the system users need to have roles assigned in the system as prerequisite for usage of NWBC. If you do not plan to use NWBC, you can skip the activities described in this section.

The SAP Best Practices roles are delivered with the SAP Best Practices add-on and are available in the system once the add-on has been applied. All user roles provide specific user menus for demo or reference purposes. These are only required if you are using the SAP NetWeaver Business Client interface, and are intended for demo
or evaluation use. If your company chooses to use these roles more extensively, they should be adjusted according to your company’s system and security policies prior to use in a production environment.

SAP Fiori user interfaces are role-based, so that the business user can access those apps that are relevant to their work and the activities they need to complete. The configuration guides included in this solution provide further details on including the SAP Fiori apps in example roles. As these are very much example roles, these roles are not included in the SAP Best Practices add-on. Furthermore these example roles are also not integrated with the roles included in the SAP Best Practices add-on.

Use
This section describes how you can assign roles for users.

Procedure

1. Choose one of the following navigation options:

<table>
<thead>
<tr>
<th>Transaction Code</th>
<th>SU01</th>
</tr>
</thead>
<tbody>
<tr>
<td>SAP Menu</td>
<td>Tools → Administration → User Maintenance → Users</td>
</tr>
</tbody>
</table>

2. In the User Maintenance screen, enter the user ID of the user for which a role assignment shall be done.

3. Choose Change.

4. In the Maintain User view, choose the Roles tab.

5. In the Role field, enter the role name. You can use a wildcard to search for a role.

You can assign several roles to a user at this stage, if necessary.

Information on which SAP Best Practices roles have to be assigned

You assign only the roles needed for a specific scenario. In this case, check the scenario business process documentation guide (BPD) of the respective scenario. The BPDs are provided in the SAP Best Practices documentation package. The necessary roles are listed in the chapter Roles in the Prerequisite section of each BPD. In addition to the roles specific to the scenario, always assign the role Employee (SAP_NBPR_EMPLOYEE_S). The assignment of this role is necessary for basic functionality.

6. Choose Enter, save, and go back to the SAP Easy Access view.

To access business objects or execute SAP transactions, a user requires corresponding authorizations, as business objects or transactions are protected by authorization objects. The authorizations represent instances of generic authorization objects and are defined depending on the activity and responsibilities of the employee. The authorizations are combined in an authorization profile that is associated with a role. The user administrators then assign the corresponding roles using the user master record, so that the user can use the appropriate transactions for his or her tasks.

SAP Best Practices does not deliver an authorization concept, i.e. the SAP Best Practices roles contain authorization objects that may not be maintained completely. However, SAP Best Practices facilitates the definition of authorization profiles by listing the SAP transactions that are necessary to perform all system activities required for the handling of the respective business scenario. Using the profile
generator you can automatically create authorization profiles covering selected system transactions. You can check the function list to get an overview of the transactions used in the different SAP Best Practices scenarios.

All authorization profiles will have to be adapted according to the necessary requirements and the authorization concept that has to be realized, respectively. Further information on this topic can be found on the SAP Help Portal at http://help.sap.com: In the search entry field enter the term User and Role Administration of AS ABAP as search term and confirm your entry. Finally, in the search results select the link to User and Role Administration of AS ABAP.

⚠️ The SAP Best Practices roles are not designed to be used as productive roles. Instead, these roles only serve the purpose to be used as demo roles that enable system users to make use of the SAP NetWeaver Business Client interface to try out the predefined business processes delivered by the SAP Best Practices Baseline package.

For productive use, never use the roles delivered directly; instead, copy them and adjust them as necessary. In addition, an authorization concept has to be defined and implemented accordingly.

Result
The roles are now assigned to the user. These roles are referred to in the business process documentation (BPDs) provided in SAP Best Practices.

4.3 Creation and Change of Queries in Personal Object Worklists (POWLs)

This section refers to information that is needed when you work with the SAP NWBC. In several business process documents it is necessary that you create or change queries. In such cases refer to the description as outlined below and provide system users with the relevant information, respectively.

4.3.1 Create Query

Use
You want to create a completely new query.

Procedure

1. Access the activity choosing the following navigation option:

   | SAP NetWeaver Business Client Menu | Production → Worklist |

2. Choose the link Define New Query. A process template takes you through the individual steps. You work through the specified steps and define the following data:

3. For selecting the object type, make the following entries:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>User Action and Values</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Object Type</td>
<td>PP operation worklist</td>
<td>By selecting an object type, you choose one of the pre-defined types of the POWL.</td>
</tr>
</tbody>
</table>
4. Choose the Next button.
5. Maintain selection criteria for your query as required.
6. Choose the Preview button to get a test view of the list.
7. Choose the Criteria Personalization link to select additional fields for the quick search.
8. Choose Next.
9. Make the following entries:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>User Action and Values</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter Query Description</td>
<td>Test</td>
<td>Example of query description</td>
</tr>
<tr>
<td>Activate Query</td>
<td>✓</td>
<td>Select checkbox to activate the query.</td>
</tr>
</tbody>
</table>

10. Choose the Finish button.

For setting your query as the default query, choose the Personalize link from the Query Area and select the Personalize View tab. In the Active Queries list, you find the Set Default Query column where you can set your query as the default query. That means that this default query is always active when you log in.

**Result**
The newly defined query has created a new work item (POWL) which appears in the query area as Tab Strip or Link Matrix.
For more information on working with POWL, refer to the guide *How to Use POWER lists* in the Enablement Kit.

### 4.3.2 Change Query

**Use**
You want to change an existing query.

**Procedure**

To show how to change an existing query we use the POWL List for Billing Documents.

1. Access the activity choosing the following navigation option:

<table>
<thead>
<tr>
<th>SAP NetWeaver Business Client Menu</th>
<th>Accounts Receivable → Billing</th>
</tr>
</thead>
</table>

2. Select the POWL Billing Documents by choosing the Billing Documents tab.
3. Choose the Change Query link.
4. Enter or adjust selection criteria to your requirements.
5. Choose the Preview button to get a test view of the list. You can export the preview to a Microsoft Excel worksheet.
6. Choose the Criteria Personalization link to select additional fields for the quick search.
7. Choose Apply.
Result
The query has been changed to your requirements.

4.4 Errors with SAP NetWeaver Business Client (SAP NWBC)

4.4.1 Queries Show No Data/No Columns

Problem Description
A query shows no data.

Error Solution Procedure
If a query shows no data, check the current selection and filter. Remember to refresh the list after changing the selection and filters.
If a query shows no columns, create a new query.

💡 Refer to the SAP Business All-In-One Enablement Kit, Building Block K51, on how to use and change existing queries and create new queries.

Some CO related queries require that the parameter ID CAC is set to the used Controlling Area as default value. Use transaction SU01 / SU3 to maintain the value.

4.4.2 Printing Functionality

Problem Description
It is not possible to show or print documents (e.g. invoices) via the system icon Print Version, Billing Document in PDF Format or similar icons.

Error Solution Procedure
The above mentioned functionality only supports PDF based forms and in some cases also SAPScript forms. It is not possible to show or print Smartforms.
5 Security Aspects

This section provides an overview of the security-relevant information that applies to the deliverables of this solution package.

5.1 General Security Guidelines

The SAPUI5 user interfaces displays information taken from backend applications. The security section provides an overview of security guides delivered by the solution.

To access the latest version of the security guide, log on to SAP Service Marketplace

5.2 User Administration and Authentication

This section provides an overview of the users required for this solution package.

<table>
<thead>
<tr>
<th>Purpose</th>
<th>User ID</th>
<th>User Type</th>
<th>Building Block Config. Guide</th>
<th>Initial Password</th>
<th>Authoriztn. Profile</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administration User</td>
<td>User ID is defined by your system administrator</td>
<td>Dialog (Type A)</td>
<td>Creation described in Quick Guide</td>
<td>Password is defined by your system administrator</td>
<td>Authorization is defined by your system administrator</td>
<td></td>
</tr>
<tr>
<td>Development User</td>
<td>User ID is defined by your system administrator</td>
<td>Dialog (Type A)</td>
<td>Creation described in Quick Guide</td>
<td>Password is defined by your system administrator</td>
<td>Authorization is defined by your system administrator</td>
<td></td>
</tr>
<tr>
<td>Business User</td>
<td>User ID is defined by your system administrator</td>
<td>Dialog (Type A)</td>
<td>Creation described in Quick Guide</td>
<td>Password is defined by your system administrator</td>
<td>Authorization is defined by your system administrator</td>
<td></td>
</tr>
</tbody>
</table>

You can check the users in transaction SU01.

5.2.1 Creation of Administration User

The administration user requires the authorization to download the software for
- UI add-on for SAP NetWeaver
- SAP NetWeaver Gateway

and apply these to the system.

5.2.2 Creation of Development User

The development user requires the authorization to configure SAP NetWeaver Gateway services and create roles. Additionally, the development user requires access to the Eclipse studio with plugins for
- SAPUI5 Plugin for Eclipse Studio
- Team Provider

installed.
5.2.3 Creation of Business User
The business user requires the back-end authorizations to execute the content, corresponding to if they were to execute in SAPGui in the back-end. In order to execute the user interfaces using SAP NetWeaver Business Client, the role containing the user interface must be assigned to the business user.

5.3 Roles Management
The package describes the example roles that you need to create to execute the user interfaces in SAP NetWeaver Business Client.

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Z_SAP_NBPR_U56_FIORI</td>
<td>SAP Fiori Examples</td>
<td>Creation of this role is described in <em>SAP Fiori User Interface</em> (building block U56)</td>
</tr>
<tr>
<td>Z_SAP_NBPR_SAPUI5_SD</td>
<td>Sales and Distribution with SAPUI5</td>
<td>Creation of this role is described in <em>SAPUI5 Configuration for Sales and Distribution</em> (building block U51)</td>
</tr>
<tr>
<td>Z_SAP_NBPR_SAPUI5_PS</td>
<td>Project Service with SAPUI5</td>
<td>Creation of this role is described in <em>SAPUI5 Configuration for Project Services</em> (building block U52)</td>
</tr>
</tbody>
</table>

💡
You can check the roles in transaction PFCG.